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TIME OFF PROCEDURES 
The steps listed below are intended to help you through how to request time off on behalf of an employee, as well as 

how to approve or correct employee submitted time off, like vacation. The same process is also used to put an 

employee on leave. 

 
APPROVAL OF TIME OFF REQUEST 

Note: Managers will be notified of leave/time off requests through the Workday inbox. 

 

1. To review the team calendar, on the Workday homepage, click View All Apps to go to the Team 
Time application.  

 

 

 

 

 

 

 

 

Employee initiates or 
changes time off request 

Manager approval

Manager initiates or 
changes time off request 

Automatic approval  

Approval path: 
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2. Select Time Off & Leave Calendar under the View menu. 

 

 

 

 

 

 

 

 

 

3. Navigate to the month of the employee’s request to view your team’s current vacation schedule.  

4. Click on the bar that houses the employee name to view details about the absence request. 

 

5. Click on one Absence Event that appears in the Details Chart.  
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6. Click Review. 

 

7. Click the appropriate action to Approve, Deny, Send back, or Cancel to close out and save for later.  
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ENTER ABSENCE FOR AN EMPLOYEE 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 

 
2. Select Enter Time for Worker from the Actions menu.  

3. Use the search bar to locate the worker you want to enter time for as well as the date. 

 

 

 

 

4. Click the Actions button and select Enter Absence. 
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5. Click the day(s) to book off in the calendar or click Select Date Range to book a larger block of time.  

 
 

6. Once dates are selected, click Request Absence to choose the absence type and select Next.  
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Note: A Reason Code for the requested Absence may be required.  A red asterisk beside the 'Reason' field 

indicates that the field is required to proceed. 

 

7. Review the time off and click Submit. 

CORRECT ABSENCE  

1. From the home page, type the employee name in the main Search bar and click the result that displays their 

name and position to navigate to their Worker Profile.  

 

2. Select Absence from the main menu on the left side of the Worker Profile. 
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3. Click Edit Absence to go to the Absence Calendar. 

 

4. From the Absence Calendar, click on the grey bar associated with the time off/leave that you would like to 

edit.  

 
5. Select the dates to be corrected and make the appropriate edits.  

Note: Days can be deleted within the chart and the Type and Quantity (number of hours) are edited in the 

fields below after selecting the days to be edited. 

6. Once completed, click Submit to finalize the transaction. 
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VIEW TEAM TIME OFF CALENDAR 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 

 
 

2. Select Time Off & Leave Calendar under the View menu. 

Note: Approved requests show with a green check mark and pending requests show in gray. You can 

approve pending requests from this screen by clicking on the request and then Review. 

 

VIEW STATUS OF REQUEST 

1. At the top right of the Workday screen, click on the Workday inbox   

2. Click on the Archive tab.  
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3. Find the relevant request in the archive list and click on it to open it in the viewing window.  
4. Within the View Event screen, click on the Process tab to view the Process History. 

 

TIME OFF PROCEDURES TROUBLE SHOOTING 

Why am I receiving a vacation request for my student or casual employee?  

• When employees have multiple positions on campus, any vacation or absence requests submitted will be 

sent to all managers for visibility, however only the manager of the absence eligible position should 

approve/deny. Once the absence request is reviewed by the appropriate manager, it will automatically be 

removed from all other managers' inboxes.  
 

My staff member’s vacation balance is wrong in Workday. How can I update it? 
2. Please reach out to hrhelp@uwaterloo.ca on behalf of your employee with the correct balance so HR can 

update it. 

 

Can I track flex or lieu time with Workday? 

• Workday’s current functionality does not include tracking lieu or flex time tracking. It only includes requests 

for vacation, leaves, and overtime tracking.  

 

mailto:workday@uwaterloo.ca
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HIRING 
HIRE A CASUAL EMPLOYEE 

 

Follow the steps below to hire your casual employee into Workday. Once the hire is finalized, the manager, 

timekeeper, or employee can enter hours worked into the time entry system for payment.  

1. Type Employee Search into the main search bar to access the search by employee ID, student ID search 

function to determine if the new employee exists in Workday.  

 
 

2. If their Employee Name: 
a. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner
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Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below.  

 

 
 

b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  

 
 

c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   
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3.  Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
Note: JM is short for Job Management. This is used to group positions without regular position numbers 

including casual and student employees. 
 

If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 
Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the employee’s contact information.  
If this is a rehire based off the Employee Search:  
Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter the 

employee’s job details.   
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ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and then select the Contact Information tab to add a home 

address and an email address.  

 

                  
 

 

 

6. Click OK to continue to the job details. 

 

Hint: Leave Source and Referred by fields blank.    

ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  

8. For Employee Type, type Casual (Fixed Term) or select it by clicking For Current Country. 
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9. In the Job Profile field, select or type Casual Staff 9010, or Casual Staff 9011 if paid from a research 

account, or 9012 -Casual Staff - Proctor, if a proctor.  

10. For Time Type, select Part Time. 
11. Select the building Location for the employee from the list.
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12. Leave Default Weekly Hours as is and update Scheduled Weekly Hours with the expected number of hours 

per week. 

13. Expand Additional Information. 

 
14. Update the Job Title to the employee’s actual title. 

Note: This ensures the correct casual position is selected when entering time for multiple casual positions. 
15. Enter an End Employment Date for the employee. 

16. If this Casual employee will be paid from a research account, please provide a short description of their job 

details in the comment box for the Office of Research to review or attach it in the file upload section.  

17. Click Submit to continue to enter SIN if this is a new hire (step 18) or to enter compensation details if this is 

a rehire (step 20). 

 

If this is a brand new hire:  

ENTER SOCIAL INSURANCE NUMBER 

18. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 

step and continue to step 20.  

 
 

Tip: If you clicked out of the pop-up, the SIN task will be in your inbox to complete or skip from there. To 

skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task and OK.  

 

a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 
the empty fields to select the following: 
 
Country – Canada 
National ID Type - Social Insurance Number  
Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

19. Click Approve. 
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 ENTER EMPLOYEE COMPENSATION INFORMATION  

20. Click Open to go to the Compensation screen. 
 

 
 

Tip: If you clicked out of the pop-up, the Compensation task will be in your inbox to complete from there.  

21. Scroll down to the Hourly section and click the edit icon.  

22. In the Amount field, enter an hourly rate. 

 
 

23. Click Submit. 
24. Click Open to continue to update the cost center. 
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ENTER CHANGE ORGANIZATION ASSIGNMENT 

25. In the Cost Center section, click the Edit icon and enter the work order and activity for the employee in 

the Cost Center field in this format xxxxx-xxxxx xxx. 

 
 

26. Click Submit. 
27. If there is only one applicable Cost Center, click Skip for Add Split Between Salary Accounts, then OK to 

send the hire to HR for review. If there is more than one cost center, click Open and see the steps below. 

   

Tip: Leave the reason field blank for skipped fields. If you clicked Open or clicked out of the pop-up instead 

of Skipping, navigate to your Workday inbox and select the gear icon (task actions) in the top right of the 

Assign Costing Allocation inbox item and click Skip This Task and then OK on the next screen to skip.  

 

If there is more than one Cost Center: 

28. Click Open to enter additional salary accounts.  

29. Select Worker and Position for the Costing Allocation Level. 
30. Click Add. 
31. Select the + to add an additional row and enter the additional cost center into the Worktags field.  

32. Enter the appropriate Distribution Percent. 

33. Click Submit. The initiation of this hire is now complete and will go to HR for review. 

 

Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. 

Click the Process tab on the resulting screen and scroll down the table to see what part of the process the 
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hire is in; OR find the submitted Hire event in the Archive section of your Workday inbox and click the 

Process tab (items are archived for 30 days).  

HIRE A STUDENT 

 

The steps outlined below will guide you through the process of hiring a co-op student, Graduate Teaching Assistant, 

and Graduate Research Assistant. To hire a Work Placement (WP), Engineering Undergraduate Research Internship 

(Eng-URI), or Undergraduate Student Research Awards (USRA) student, please view the work instructions specific to 

this group of student hires. 

 

1. Type Employee Search into the main search bar to access the search by employee ID, student ID function 

to determine if the new employee exists in Workday.  

 
2. If their Employee Name: 

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner

https://uwaterloo.ca/workday/workday-user-guides/hire-work-placementuriusra-student
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a. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below. 

 
 

b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  

 
 

c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   
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3.  Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
 

Note: JM is short for Job Management. This is used to group positions without position numbers 

including casual, student and non-faculty appointments (i.e. post-doctoral fellows, research 
associates).  
 

If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 
Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the student’s contact information.  
If this is a rehire based off the Employee Search:  
Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter the 

employee’s job details.   
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ENTER THE STUDENT’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and select the Contact Information tab to add a home 

address and an email address.  

                  
 

 

6. Click OK to continue to the job details. 

Hint: Entering Source and Referred by information is optional.   

ENTER THE STUDENT’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  

Tip: If requesting 4 equal payments, enter the first day of the month of the applicable term.  

8. Enter the appropriate Employee Type by selecting For Current Country> Student (Fixed Term).  
9. In the Job Profile field, select or type the appropriate one from the list below:  

Co-op: 7661 
Undergrad Teaching Assistant: 7835 

Undergrad Research Assistant: 7836 

Graduate Teaching Assistant: 1671 

Graduate Research Assistant: 1672 

10. Select the appropriate Time Type (if 35 hours or greater, select Full Time, otherwise select Part Time). 
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11. Select the building Location for the employee from the list of All Locations. 
12. Update Default Hours with the number of working hours per week to automatically adjust Scheduled 

Weekly Hours to the same amount. 

Tip: Updating the Default Weekly Hours will avoid proration of the salary amount, by adjusting the FTE to 

100%.  

13. Expand Additional Information. 

 
14. Enter an End Employment Date for the employee. 

Tip: If requesting 4 equal payments, enter the last day of the month of end of the term.  

15. If this student employee will be paid from a research account, please provide a short description of their job 

details in the comment box.  

16. Click Submit to continue to enter SIN if this is a new hire (step 17) or to enter compensation details if this is 

a rehire (step 19). 

 

If this is a brand new hire:  

ENTER SOCIAL INSURANCE NUMBER 

17. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 

step and continue to step 19.  

 
Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 

there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 

and OK.  

 

a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 
the empty fields to select the following: 
 
Country – Canada 
National ID Type - Social Insurance Number  
Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

18. Click Approve. 
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ENTER STUDENT COMPENSATION INFORMATION  

19. Click Open to go to the Compensation screen.   
 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  

 
20. In the Salary section, click the Edit icon and enter a monthly salary in the Amount field and select 

Monthly in the Frequency field.  

21. Click Additional Details underneath Frequency to expand the fields. 

22. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered on 

the job details screen).  
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23. Click Submit to continue to the account entry section and follow the steps below.   

ENTER CHANGE ORGANIZATION ASSIGNMENT 

24. Click Open.  
 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  
 

25. In the Cost Center section, click the Edit icon and enter the work order and activity for the employee in 

the Cost Center field in this format xxxxx-xxxxx xxx. 
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26. Click Submit. 
27. If there is only one applicable Cost Center, click Skip for Add Split Between Salary Accounts, then OK to 

send the hire to HR for review. If there is more than one cost center, click Open and see the steps below. 

 

Tip: Leave the reason field blank for skipped fields. If you clicked Open or clicked out of the pop-up instead 

of Skipping, navigate to your Workday inbox and select the gear icon (task actions) in the top right of the 

Assign Costing Allocation inbox item and click Skip This Task and then OK on the next screen to skip.  

 

If there is more than one Cost Center: 
28. Click Open to enter additional salary accounts.  

29. For Costing Allocation Level, select Worker and Position. 

30. Click Add.  
31. Select the + button to add an additional row and enter the additional cost center to the Worktags field. 

32. Enter the appropriate Distribution Percent.  
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33. Click Submit and Done. The initiation of this hire is now complete and will go to HR for review.  

 

Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. 

Click the Process tab on the resulting screen and scroll down the table to see what part of the process the 

hire is in; OR find the submitted Hire event in the Archive section of your Workday inbox and click the 

Process tab (items are archived for 30 days). 

HIRE A WORK PLACEMENT STUDENT 

 

The steps outlined below will guide you through the process of hiring a Work Placement (WP) student.  

1. Type Employee Search into the main search bar to access the search by employee ID, student ID search 

function to determine if the new employee exists in Workday.  

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner
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2. If their Employee Name: 

a. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below. 

 
 

b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  



| 31 
 

 
 

c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   

 

 
3. Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
Note: JM is short for Job Management. This is used to group positions without position numbers 

including casual and student hires.  
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If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 
Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the employee’s contact information. 

If this is a rehire based off the Employee Search:  
Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter 
the employee’s job details. 
 

 
 

ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and select the Contact Information tab to add a home 

address and an email address.  

 

                  
 

 

6. Click OK to continue to the job details. 
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ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  

 Tip: If requesting 4 equal payments, enter the first day of the month of the applicable term.  

8. Enter the appropriate Employee Type by selecting For Current Country> Student (Fixed Term).  
9. In the Job Profile field, select or type Co-op 7661.  
10. Select the appropriate Time Type (if 35 hours or greater, select Full Time, otherwise select Part Time). 

11. Select the building Location for the employee from the list of All Locations or type the abbreviation. 

12. Update Default Hours with the number of working hours per week to automatically adjust Scheduled 
Weekly Hours to the same amount. 

Tip: Updating the Default Weekly Hours will avoid proration of the salary amount, by adjusting the FTE to 

100%.  

13. Expand Additional Information to enter the employment end date. 

 
14. Enter an End Employment Date for the employee. 

Tip: If requesting 4 equal payments, enter the last day of the month of end of the term.  

15. Enter a comment as to when the Work Placement Application form was sent to Student Awards and 

Financial Aid (SAFA).  

16. If this student employee will be paid from a research account, please provide a short description of their job 

details in the comment box.  

17. Click Submit to continue to enter SIN if this is a new hire (step 18) or to enter compensation details if this is 

a rehire (step 20). 

 

If this is a brand new hire:  

ENTER SOCIAL INSURANCE NUMBER 

18. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 

step and continue to step 20.  

 

Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 

there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 

and OK. 
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a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 
the empty fields to select the following: 
 
Country – Canada 
National ID Type - Social Insurance Number  
Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

19. Click Approve. 

 

ENTER EMPLOYEE COMPENSATION INFORMATION  

20. Click Open to go to the compensation screen. 

 
 

Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  
 

21. Skip to step 24 if no top up is being provided, otherwise, if the department is paying a top up, enter the total 

top up amount (i.e. $625 from one account+$1200 from another account = $1825 -> enter this total top up 

amount) in the Salary section and for Frequency, select Monthly.  

22. Click Additional Details underneath Frequency to expand the fields. 

23. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered 

on the job details screen).  
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Tip: The payments will be split into the appropriate accounts in the Assign Multiple Funding Sources section (up 

next). 

24. If no top up is being provided, click the X in the Salary section and Delete to close it.  

25. Scroll down to click Add in the Allowance section.  

 
26. Click in the Compensation Plan field and select All Compensation Plans to choose Work Placement 

Funding.  
27. In the amount field, enter $2200. 
28. Click Additional Details underneath Frequency to expand the fields. 

29. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered 

on the job details screen).  

Tip: Vacation percentage will be automatically calculated. Do not add it here.  
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30. Click Submit to continue on to the account entry screen (Change Organization Assignment).  

 

ENTER CHANGE ORGANIZATION ASSIGNMENT 

31. Click Open.  

 

Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  
 

32. Click the Edit icon for Cost Center and enter the work placement account information as 10000-10738 

100. 
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33. Click Submit. 
34. Click Skip for Add Split Between Salary Accounts if only being paid the work placement funding and click 

OK and Done to complete the hire OR if there is a department top up, continue to next step.  

 
Tip: If you clicked Open or clicked out of the pop-up instead of Skipping, navigate to your Workday inbox 

and select the gear icon (task actions) in the top right of the Assign Costing Allocation inbox item and click 

Skip This Task and then OK on the next screen to skip.  

 

 If there is a department top up: 
35. Click Open to enter the department top up account.   

36. For Costing Allocation Level, select Worker and Position. 

37. Click Add.  
38. In the resulting table, enter the department work order and activity in the Worktags field. If only 

entering one salary account, click Submit and Done to send the hire to HR for review.  

If more than one salary account needs to be added, continue to the next step.  

Tip: This screen is for the department top up accounts only. Do not enter the Work Placement account on 

this screen.  

39. If more than one account for the department salary amount, click the + in the table to add a row and enter 

the additional work order in the Worktags field and press enter. 

40. Enter the appropriate Distribution Percent.  

 
 

Tip: To determine the distribution percentage, add together the department amounts (i.e. Dean and faculty 

payments) and divide each individual amount by the combined total (e.g. if $625 from the Dean's account and 

$1200 from faculty account it would be $625/$1825 = 34% for Dean's portion, and the other account would be 

the remaining 66%). 
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41. Click Submit and Done. The initiation of this hire is now complete and will go to HR for review.  

 
Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. 

Click the Process tab on the resulting screen and scroll down the table to see what part of the process the 

hire is in; OR find the submitted Hire event in the Archive section of your Workday inbox and click the 

Process tab (items are archived for 30 days). 

 

 HIRE AN ENGINEERING URI STUDENT  

 

The steps outlined below will guide you through the process of hiring an Engineering Undergraduate Research 

Internship (Eng-URI) student. This process is to be used by the Faculty of Engineering only. If the student is 

receiving Dean’s Office Top Up funding without the Eng-URI program funding, please proceed with the Hire a 

Student user guide instead.  

1. Type Employee Search into the main search bar to access the search by employee ID, student ID search 

function to determine if the new employee exists in Workday.  

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner
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2. If their Employee Name: 

a. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below. 

 
 

b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  
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c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   

 
 

3. Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
Note: JM is short for Job Management. This is used to group positions without position numbers 

including casual and student hires.  
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If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 

Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the employee’s contact information. 

If this is a rehire based off the Employee Search:  

Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter 

the employee’s job details.   

 

ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and select the Contact Information tab to add a home 

address and an email address.  

 

 
 

6. Click OK to continue to the job details.  

ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  

Tip: If requesting 4 equal payments, enter the first day of the month of the applicable term.  

8. Enter the Employee Type by selecting For Current Country> Student (Fixed Term).  
9. In the Job Profile field, select or type Eng Undergrad Research Intern (Eng-URI) 7663. 

10. Select the appropriate Time Type (if 35 hours or greater, select Full Time, otherwise select Part Time). 

11. Select the building Location for the employee from the list of All Locations or type the abbreviation. 

12. Update Default Hours with the number of working hours per week to automatically adjust Scheduled 
Weekly Hours to the same amount. 

Tip: Updating the Default Weekly Hours will avoid proration of the salary amount, by adjusting the FTE to 

100%.  

13. Expand Additional Information to enter the employment end date. 



| 42 
 

 
14. Enter an End Employment Date for the employee. 

Tip: If requesting 4 equal payments, enter the last day of the month of end of the term.  

15. If this student employee will be paid from a research account, please provide a short description of their job 

details in the comment box.  

16. Click Submit to continue to enter SIN if this is a new hire (step 17) or to enter compensation details if this is 

a rehire (step 19). 

 

If this is a brand new hire:  

ENTER SOCIAL INSURANCE NUMBER 

17. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 
step and continue to step 19.  
 

 
 
Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 
there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 
and OK. 
 
a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 

the empty fields to select the following: 
 
Country – Canada 
National ID Type - Social Insurance Number  
Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

18. Click Approve. 

 

ENTER EMPLOYEE COMPENSATION INFORMATION  

19. Click Open to go to the compensation screen. 
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Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  
 

20. In the Salary section, enter the total salary top up amount that is not including the Eng-URI or Dean’s Top 

Up. Frequency should default to Monthly.  
Note: If receiving a salary of $1800 paid by two different work orders, enter the total $1800 in the amount 

field -> the salary will be split into the appropriate accounts in the multiple funding source step. 

21. Click Additional Details underneath Frequency to expand the fields. 

22. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered 

on the job details screen).  

  
 

23. Scroll down to click Add in the Allowance section.  
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24. Click in the Compensation Plan field and select All Compensation Plans to choose Eng-URI Program 

Funding.  
25. The amount field will populate to $450. 
26. Click Additional Details underneath Frequency to expand the fields. 

27. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered 

on the job details screen).  

 

  
 

28. Repeat steps 23-27 to add the Eng Dean’s Office Top Up allowance if applicable.  

29. Click Submit to continue on to the account entry screen (Change Organization Assignment).  

ENTER CHANGE ORGANIZATION ASSIGNMENT 

30. Click Open.  
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Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

31. In the Cost Center section, click the Edit icon and enter the Eng-URI account information as follows: 10021-

10174 801. 

 
32. Click Submit. 

Note: The account information for the Dean’s top up allowance plan is hard coded into the system and does 

not need to be entered.  
 

33. Click Open to enter the department salary top up account(s).   

 
 

Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

34. For Costing Allocation Level, select Worker and Position. 

  

35. Click Add.  
36. In the resulting table, enter the department (salary top up) work order and activity in the Worktags field 

of the first row. If only entering one salary account, click Submit and Done to send the hire to HR for 

review. If more than one salary account needs to be added, continue to the next step.  
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Tip: This screen is for the department top up accounts only. Do not enter the Eng-URI or Dean’s top up 

account on this screen.  

37. If more than one account for the department salary amount, click the + in the table to add a row to enter any 

additional accounts as applicable.  

38. Enter the appropriate Distribution Percent.  

 
39. Click Submit and Done. The hire is now complete and will go to HR for review.  

 Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. Click the 

Process tab on the resulting screen and scroll down the table to see what part of the process the hire is in; OR find 

the submitted Hire event in the Archive section of your Workday inbox and click the Process tab (items are 

archived for 30 days). 

HIRE A USRA STUDENT 

 

The steps outlined below will guide you through the process of hiring an Undergraduate Student Research Awards 

(USRA) student.  

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner
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1. Type Employee Search into the main search bar to access the search by employee ID, student ID search 

function to determine if the new employee exists in Workday.  

 
2. If their Employee Name: 

a. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below. 

 
 

b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  
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c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   

 
3. Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title. 

 
Note: JM is short for Job Management. This is used to group positions without position numbers 
including casual and student hires.  

 
If you have not performed the Employee Search, please see step 2 before continuing. 
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4. a)     If the Employee Search produced no results: 
Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the employee’s contact information. 

b) If this is a rehire based off the Employee Search:  
Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter 

the employee’s job details.   

ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and select the Contact Information tab to add a home 

address and an email address.  

 

                  
 

 

6. Click OK to continue to the job details. 

ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record). 

Tip: If requesting 4 equal payments, enter the first day of the month of the applicable term.  

8. Enter the appropriate Employee Type by selecting For Current Country> Student (Fixed Term).  
9. In the Job Profile field, select or type Co-op 7661.  

10. Select the appropriate Time Type (if 35 hours or greater, select Full Time, otherwise select Part Time). 

11. Select the building Location for the employee from the list of All Locations or type the abbreviation. 

12. Update Default Hours with the number of working hours per week to automatically adjust Scheduled 
Weekly Hours to the same amount. 

Tip: Updating the Default Weekly Hours will avoid proration of the salary amount, by adjusting the FTE to 

100%.  

13. Expand Additional Information to enter the employment end date. 

 
14. Enter an End Employment Date for the employee. 
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Tip: If requesting 4 equal payments, enter the last day of the month of end of the term.  

15. If this student employee will be paid from a research account, please provide a short description of their job 

details in the comment box.  

16. Click Submit to continue to enter SIN (step 17) if this is a new hire or to enter compensation details if this is 

a rehire (step 19). 

 

If this is a brand new hire:  

ENTER SOCIAL INSURANCE NUMBER 

17. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 
step and continue to step 19. 
 

 
 
Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 
there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 
and OK. 
 
a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 

the empty fields to select the following: 
 
Country – Canada 
National ID Type - Social Insurance Number  
Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

18. Click Approve. 

 

ENTER EMPLOYEE COMPENSATION INFORMATION  

19. Click Open to go to the compensation screen. 
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Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  

20. In the Salary section, click the X and Delete to close it.   

Tip: The supplementary payment/top up will be added as an allowance plan as it is non-taxable. 

21. Scroll down to click Add in the Allowance section. 

 
22. Click in the Compensation Plan field and select All Compensation Plans to choose NSERC USRA 

Scholarship Top Up. 

23. Enter the total applicable NSERC USRA top up amount (i.e. $625+$1200 = $1825  enter this total 

amount) 

Tip: The NSERC USRA is paid through Quest as a scholarship, do not add the $1,125/month. 

24. Click Additional Details underneath Frequency to expand the fields. 

25. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered 

on the job details screen).  
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26. Click the Submit to continue on to the account entry screen (Change Organization Assignment). 

ENTER CHANGE ORGANIZATION ASSIGNMENT 

27. Click Open.  

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

28. In the Cost Center section, click the Edit icon and enter the work order and activity for the NSERC USRA 

top up payment.  

 
29. Click Submit. 
30. If there is only one applicable Cost Center, click Skip for Add Split Between Salary Accounts, then OK to 

send the hire to HR for review OR, if there is more than one funding source f0r the top up, continue to the 

next steps below.  

 
Tip: If you clicked Open or clicked out of the pop-up instead of Skipping, navigate to your Workday inbox and select 

the gear icon (task actions) in the top right of the Assign Costing Allocation inbox item and click Skip This Task and 

then OK on the next screen to skip.  
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If there is more than one Cost Center: 
31. Click Open to enter additional NSERC USRA top up accounts.   

32. For Costing Allocation Level, select Worker and Position. 

  

 

33. Click Add.  
34. In the resulting table, enter the department (salary top up) work order and activity in the Worktags field. 

If only entering one salary account, click Submit and Done to send the hire to HR for review. If more than 

one salary account needs to be added, continue to the next step.  

35. If more than one account for the department salary amount, click the + in the table to add a row and enter 

the additional account in the Worktags field.  

36. Enter the appropriate Distribution Percent.  
 

Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. Click 

the Process tab on the resulting screen and scroll down the table to see what part of the process the hire is in; 

OR find the submitted Hire event in the Archive section of your Workday inbox and click the Process tab (items 

are archived for 30 days). 
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HIRE A WORK STUDY EMPLOYEE 

 

The steps outlined below will guide you through the process of hiring a Work Study employee in Workday.  

1. Type Employee Search into the main search bar to access the search by employee ID, student ID search 

function to determine if the new employee exists in Workday.  

 
2. If their Employee Name: 

a. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below. 

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner
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b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  

 
 

c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   
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3.  Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
Note: JM is short for Job Management. This is used to group positions without position numbers 
including casual and student hires. 
 

If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 
Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the employee’s contact information. 

If this is a rehire based off the Employee Search:  
Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter 

the employee’s job details.   

 ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and select the Contact Information tab to add a home 

address and an email address.  
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6. Click OK to continue to the job details. 

ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  

8. Select or type Casual (Fixed Term) in the Employee Type list. 

9. In the Job Profile field, select or type Casual – Int’nl Work Study OR Casual – Ontario Work Study. 

10. For Time Type, select Part Time. 

11. Select the building Location for the employee from the list. 

12. Leave Default Weekly Hours as is and update Scheduled Weekly Hours with the expected number of 

hours per week. 

13. Expand Additional Information. 

 
14. Update the Job Title to the employee’s actual title. 

Note: This ensures the correct casual position is selected when entering time for multiple casual positions. 
15. Enter an End Employment Date for the employee. 

16. Click Submit to continue to enter SIN if this is a new hire (step 17) or to enter compensation details if this is 

a rehire (step 19). 

 

If this is a brand new hire:  

ENTER SOCIAL INSURANCE NUMBER 

17. Click Open to add a Social Insurance Number (SIN) OR click View Details and then Skip to skip this step 
and continue to step 19.  
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Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 
there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 
and OK. 
 
a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 

the empty fields to select the following: 
 
Country – Canada 
National ID Type - Social Insurance Number  
Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

18. Click Approve. 

 

ENTER EMPLOYEE COMPENSATION INFORMATION  

19. Click Open to go to the compensation screen. 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.  

 

20. Click the edit icon in the Hourly section. 

21. In the Amount field, enter an hourly rate.  
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22. Click Submit to continue on to the salary account details. 

ENTER CHANGE ORGANIZATION ASSIGNMENT 

23. Click Open to continue to update the cost center. 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

24. In the Cost Center section, click the Edit icon. 

 
25. Enter the Work Study work order and activity for the employee (Ontario WS: 10000-10739 100 or 

International WS: 10000-10706 100). 

26. Click Submit. 
27. Click Open for Add Split Between Salary Accounts. 
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Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

28. In the Costing Allocation Level field, select Worker and Position. 
29. Click Add to open the account fields.  

 
 

30. Click the + in the table to add a new row and enter the department work order and activity in the 

Worktags field and press Enter on the keyboard. 

31. In the *Distribution Percent field, enter 25 for the department owned account and 75 for the Work Study 

account. 

  
 

32. Click Submit to send to HR for review.  

Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. 
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Click the Process tab on the resulting screen and scroll down the table to see what part of the process the 

hire is in; OR find the submitted Hire event in the Archive section of your Workday inbox and click the 

Process tab (items are archived for 30 days). 

HIRE FOR A ONE-TIME PAYMENT 

 

The steps outlined below will guide you through the process of entering a one-time payment in Workday and should 

be used for non-UW employees who are receiving the following types of payments in Canadian currency: 

• Award 

• External guest speaker/lecturer 

• External reviewer/examiner/assessor 

• External Prize 

• Honourarium of $500 or less 

• Research participant payment of more than $300  

 

Individuals who qualify for the above payments will need to be hired into Workday as casual employees as per 

the process outlined below, however they will not receive the onboarding steps within Workday.  

If the payee is external but does not fall into one of the categories listed above, or if they are already active in 

Workday, reference the Payment Types chart to determine how to proceed. Questions regarding payment types 

can be directed to payroll@uwaterloo.ca. Payments to existing/active staff and faculty should be completed on 

the paper One-Time Payment Request Form.  

 

Any payments that are to be made in a foreign currency must be submitted on the Foreign Fund Payment 

Request Form along with a Wire transfer form (if applicable) and sent to Payroll in EC 1.   

 

1. Type Employee Search into the main search bar to search by employee ID and/or student ID if known, or 

first and last name to determine if the payee exists in Workday.  

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner

mailto:payroll@uwaterloo.ca
https://uwaterloo.ca/human-resources/sites/ca.human-resources/files/uploads/files/one_time_payment_request_form.pdf
https://uwaterloo.ca/human-resources/sites/ca.human-resources/files/uploads/files/foreign_fund_request_form.pdf
https://uwaterloo.ca/human-resources/sites/ca.human-resources/files/uploads/files/foreign_fund_request_form.pdf
https://uwaterloo.ca/finance-resources/sites/ca.finance-resources/files/uploads/files/Outgoing_Wire_Payment_Request.pdf
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2. If their Employee Name: 

a. Appears as a hyperlink: They are an active employee – submit a paper One-Time Request Form to 

Payroll in EC 1.  

Note: If you are a manager and this is a former employee who most recently reported to you or is a 

retiree, their name will appear as a hyperlink, but there will be no Add Job option. In this case 

proceed with option “b” below. 

 
 

b. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  

https://uwaterloo.ca/human-resources/sites/ca.human-resources/files/uploads/files/one_time_payment_request_form.pdf
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c. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   

 

 

3. Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
Note: JM is short for Job Management. This is used to group positions without position numbers 

including casual and student employees. 
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If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 
Select Create a New Pre-Hire and click OK to continue to the individual’s contact information. 

If this is a rehire based off the Employee Search:  
Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter 
the employee’s job details.   

 

 

ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and then select the Contact Information tab to add contact 

information. 

Note: If this employee will not be logging into Workday to provide direct deposit information, leave the 

email address blank. If blank, they will not receive a watIAM email to create a user name for Workday. 

Address is required for these types of payments. 

                  

 

 

 

 

 

 

6. Click OK to continue to the job details. 

 

Hint: Leave Source and Referred by sections blank.   

ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  
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8. In Employee Type, select For Current Country then select Casual (Fixed Term), or type “Casual (Fixed 

Term)” in the empty search field. 

 
 

9. For Job Profile, select or type One-Time Payment Recipient 9400. 

10. For Time Type, select Part Time. 

11. Select the building Location for the employee from the list or type in the abbreviation. 

12. Pay Rate Type should be Hourly.  
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13. Leave Default Weekly Hours and Scheduled Weekly Hours as they are.  

14. Expand Additional Information. 

 
15. Leave the Job Title as is. 

16. Enter an End Employment Date within the current pay period.  

Tip: the end date should be within the current pay period to allow time for the payment to be processed 

prior to the termination date.  

17. If this one-time payment will be paid from a research account, please provide a short description of the 

appointment details in the comment box for the Office of Research to review.  

18. Click Submit to continue to enter SIN if this is a new hire (step 19) or to enter compensation details if this is 

a rehire (step 21). 

Tip: An alert will come up because this person is listed as Part-Time with 35 hours. Click Submit again 

without making any changes to continue.  

ENTER SOCIAL INSURANCE NUMBER 

19. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 

step if this is not a Canadian Resident and continue to step 21. 

 
Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 

there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 

and OK. 

 

If entering a SIN: 

a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 
the empty fields to select the following: 
Country - Canada  

National ID Type - Social Insurance Number  

Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

20. Click Approve. 

 

https://uwaterloo.ca/human-resources/support-employees/payroll/pay-dates
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ENTER ONE-TIME PAYMENT INFORMATION  

21. Click Open to enter the payment details. 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.   

 

22. In the Effective Date field, enter today’s date or a future date if this payment is to be future-dated. 

23. Leave other fields in this section blank.  

24. Click the Add button in the One-Time Payment section below.  
 

 
 

25. In the One-Time Payment Plan, select All Plans and then the appropriate payment type.  

26. For Scheduled Payment Date, enter today’s date. 

27. Enter the payment amount.  

28. Leave Send to Payroll checked on.  

29. Enter a description in the Additional Information section, providing details of what the payment is for. 
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30. Click Submit.  

 

ENTER CHANGE ORGANIZATION ASSIGNMENT 

31. Click Open to continue to update the cost center. 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there.   

 

32. Click the Edit icon in the Cost Center section. 
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33. Enter the Cost Center for the employee. 

34. Click Submit. 
35. If there is only one applicable Cost Center, click Skip for Add Split Between Salary Accounts, then OK to 

send the hire to HR for review. If there is more than one cost center, click Open and see the steps below. 

 
 

Tip: Leave the reason field blank for skipped fields. If you clicked Open or clicked out of the pop-up instead 

of Skipping, navigate to your Workday inbox and select the gear icon (task actions) in the top right of the 

Assign Costing Allocation inbox item and click Skip This Task and then OK on the next screen to skip.  

 
If there is more than one Cost Center: 
36. Click Open to enter additional salary accounts.  

37. Select Worker and Position for the Costing Allocation Level. 
38. Click Add.  
39. Select the + button to add an additional row and enter the additional cost center into the Worktags field. 

40. Enter the appropriate Distribution Percent.  

 
41. Click Submit and Done. The initiation of this hire is now complete and will go to HR for review.  

 

Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. Click 

the Process tab on the resulting screen and scroll down the table to see what part of the process the hire is in; 

OR find the submitted Hire event in the Archive section of your Workday inbox and click the Process tab (items 

are archived for 30 days). 
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HIRE A SPONSORED STUDENT 

 

The steps outlined below will guide you through the process of hiring an Undergraduate Research Internship (URI), 

student.  

1. Type Employee Search into the main search bar to access the search by employee ID, student ID search 

function to determine if the new employee exists in Workday.  

 
2. If their Employee Name: 

1. Appears as a hyperlink: They are an active employee – hover over the Employee Name to click 

the related actions (3 dots) and hover over Job Change to select Add Job and continue from step 
3 below.  

Note: if you are a manager and this is a former employee who most recently reported to you, their 

name will appear as a hyperlink, but there will be no Add Job option. In this case proceed with 

option “b” below. 

Onboarding - update banking, SIN, contact information, etc. 
Employee

Hire finalization
Human Resources Administration (HR Ops Partner) 

Consolidated approval - compensation and funding sources
˖ Signing authority˖ Office of Research (if paid from a research account)

Hire review - job details (dates, employee type, hours)
Human Resources Administration (HR Ops Partner)

Hire review - job details (dates, employee type, hours)
Manager (if initiator is not the Manager or a delegated approver)

Hire initiation
˖ Manager ˖ Delegate ˖ Campus Partner
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2. Appears in the search results as text, not a hyperlink: They are a former employee in Workday - 

hover over the Pre-Hire Name to click the related actions (3 dots) and select Hire to rehire them 

and continue to step 3 below.  

 
 

3. Does not appear: They are brand new to Workday – Type Hire Employee in the main search bar 

to hire them into the system and follow the steps below.   
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3. Type the manager name of the supervisory organization (sup org) you are hiring into, in the Supervisory 

Organization search field and press enter to pull up a list of available sup orgs. From the available options, 

select the appropriate one with 'JM' denoted in the title.

 
Note: JM is short for Job Management. This is used to group positions without position numbers 
including casual and student hires.  

If you have not performed the Employee Search, please see step 2 before continuing. 

 

4. If the Employee Search produced no results: 

Select Create a New Pre-Hire if the employee was not found in the Employee Search and click OK to 

continue to the employee’s contact information. 

If this is a rehire based off the Employee Search:  

Their name will now be populated in the Existing Pre-Hire field. Click OK to continue to step 7 – Enter 

the employee’s job details.   

 

ENTER THE EMPLOYEE’S CONTACT INFORMATION 

5. Enter the employee’s First and Last Name and select the Contact Information tab to add a home 

address and an email address.  

 



| 73 
 

 
 

6. Click OK to continue to the job details.  

ENTER THE EMPLOYEE’S JOB DETAILS 

7. Enter the Hire Date and choose the appropriate Reason (New Hire if brand new, Rehire if there was a 

previous Workday record).  

Tip: If requesting 4 equal payments, enter the first day of the month of the applicable term(s).  

8. Enter the appropriate Employee Type by selecting For Current Country> Student (Fixed Term).  
9. In the Job Profile field, select or type Sponsored Student 1572. 

10. For Time Type, select Full Time. 
11. Select the building Location for the employee from the list of All Locations or type the abbreviation. 

12. Leave Default Hours and Scheduled Weekly Hours as 35.  

13. Expand Additional Information to enter the employment end date. 

 
14. Enter an End Employment Date for the employee. 

Tip: If requesting equal payments, enter the last day of the month.  
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15. Click Submit to continue to enter SIN details. 

 

 
 

ENTER SOCIAL INSURANCE NUMBER 

16. Click Open to add a Social Insurance Number (SIN) OR click Skip and OK on the next screen to skip this 

step if not a Canadian Resident and continue to step 18. 

 
Tip: If you clicked Open or out of the pop-up, the SIN task will be in your inbox to complete or skip from 

there. To skip it from your inbox, click the gear icon at the top right of the task and select Skip This Task 

and OK. 

If entering a SIN: 

a) Click the + under the National IDs table to add the Canadian Social Insurance Number (SIN). Click in 
the empty fields to select the following: 
Country - Canada  

National ID Type - Social Insurance Number  

Add/Edit ID - 9 digit Social Insurance Number 

Issued Date - Leave blank 

Expiration Date - Enter if Social Insurance Number starts with a “9”, otherwise leave blank 

17. Click Approve. 
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ENTER EMPLOYEE COMPENSATION INFORMATION  

18. Click Open to go to the compensation screen. 

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

19. Click the X in the Salary section and Delete to close it.  

 
 

20. Scroll down to click Add in the Allowance section. 

21. Click in the Compensation Plan field and select All Compensation Plans to choose Student Refugee 
Program Stipend. 

22. In the Amount field, enter the applicable monthly payment amount  
23. Click Additional Details underneath Frequency to expand the fields. 
24. Enter the Actual End Date to be the same as the End Employment Date (i.e. the end date that was entered 

on the job details screen).  
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25. Click Submit to continue on to the account entry screen (Change Organization Assignment).  

ENTER CHANGE ORGANIZATION ASSIGNMENT 

26. Click Open.  

 
Tip: If you clicked out of the pop-up, navigate to your Workday inbox and continue the task from there. 

 

27. In the Cost Center section, click the Edit icon and enter the work order and activity in the format xxxxx-

xxxxx xxx.   
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28. Click Submit. 
29. If there is only one applicable Cost Center, click Skip for Add Split Between Salary Accounts, then OK to 

send the hire to HR for review. If there is more than one cost center, click Open and see the steps below. 
 

 
Tip: Leave the reason field blank for skipped fields. If you clicked Open or clicked out of the pop-up instead 

of Skipping, navigate to your Workday inbox and select the gear icon (task actions) in the top right of the 

Assign Costing Allocation inbox item and click Skip This Task and then OK on the next screen to skip.  

 

If there is more than one Cost Center: 
30. Click Open to enter additional salary accounts.  

31. For the Costing Allocation Level, select Worker and Position. 

32. Click Add.  
33. Select the + button to add an additional row and enter the additional cost center into the Worktags field. 

34. Enter the appropriate Distribution Percent.  
35. Click Submit and Done. The initiation of this hire is now complete and will go to HR for review.  

 

Tip: To view the status of your hire, type the employee’s name into the main Workday search bar and press 

enter. Make sure All of Workday is selected under Categories and click the Hire:(employee name) link. Click 

the Process tab on the resulting screen and scroll down the table to see what part of the process the hire is in; 

OR find the submitted Hire event in the Archive section of your Workday inbox and click the Process tab 

(items are archived for 30 days). 

CANCEL A HIRE 

If a hire was submitted in error, this process can be cancelled and then resubmitted with the correct information if 

necessary.   

The hire can be cancelled in two ways: 

1. From the Archive section of your Workday Inbox: 
   1.    Locate the Hire or Start Additional Job event.  
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1. At the bottom of the screen, there will be the option to Cancel. 

Note: If you need to update a hire detail such as a start or end date prior to final approval, click Cancel to 

start over or contact the individual or team that the hire is awaiting approval with to have them send the hire 

back to you to correct and resubmit (click the Process tab to see who the hire is sitting with).  

 
2. Scroll down to the end of the hire details to enter a comment in the comment field box and click Submit once 

complete.  
Tip: If you cancelled and are redoing the hire, the employee created will still exist in the system as a Pre-

Hire and upon re-entering the Hire Details, you will be able to select Existing Pre-Hire rather than creating 

them again.  

 

2. By typing the employee name into the Workday search bar: 
1. Type the employee’s name into the main workday search bar and press enter on the keyboard.  

2. Select All of Workday under Categories on the left-hand side. 

3. Find the overall process you have initiated (i.e. for a hire/rehire – Hire: Sam Smith. For an Add Job – Start 
Additional Job: Sam Smith) and hover over it to bring up the related actions (3 orange dots).  

4. Click the related actions (3 orange dots) and hover over Business Process to select Cancel.  

5. Scroll down to the end of the hire details to enter a comment in the comment field box. 
6. Click Submit once complete.  

Tip: If you cancelled and are redoing the hire, the employee created will still exist in the system as a Pre-

Hire and upon re-entering the Hire Details, you will be able to select Existing Pre-Hire rather than creating 

them again.  
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HIRE TROUBLE SHOOTING 

What steps need to be submitted for a hire to go through for approvals?  

1. Hire Details screen 

2. Social Insurance Number – only for brand new employees; skippable 

3. Propose Compensation  

4. Change Organization Assignments (cost center) 

5. Add Split for Salary Accounts (costing allocations); skippable  

When will my hire be finalized?  

The hire will be finalized once it goes through all of the approvals in Workday. The typical approval path looks like 

this – Initiator > Human Resources > Supervisory Org Manager (if not Initiator) > Cost Center Manager > Office of 
Research (if paid from a research account) > Human Resources (final review).  You can monitor the process by 

checking the status of your hire.  

New hires must complete onboarding action items once the hire is finalized to ensure there is no delay in payments. 

You can view your direct reports’ onboarding status by clicking the Onboarding Status Summary application from 

your Workday home screen.  
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When will the employee receive notification to log into Workday? 

The new employee will receive an invitation email from WatIAM as soon as the hire is finalized in Workday. This 

invitation will ask them to click 1 of 2 links – one to claim their WatIAM if they already have one, OR one to create a 

new WatIAM for brand new employees. A link to sign into Workday will also be provided. They will also receive a 

Daily Digest email from Workday to let them know there are onboarding action items to complete in their Workday 

inbox.  

 

Why was my hire denied?  

To view the comments for denied hires, click the notification link found in the body of the notification to go to the hire 

event details page. From there, click the Process tab beside Details (underneath Overall Status) and scroll down to 

view the comments in the last column. Common reasons for hires to be denied are: 

• The employee already exists as a pre-hire (use the existing employee ID to hire) 

• The employee is currently working at UW (use the Add Job process to hire) 

• Multiple instances of the same hire have been initiated. In this case, HR will deny the duplicates.  

 

How do I check the status of my hire? 

1. Type event: followed by the employee’s name into the main Workday search bar and press enter. 

2. Find the Hire: Employee Name event (i.e. Hire: John Doe) and click on it to go to the hire event details 

page. 

3. From there, click the Process tab beside Details (underneath Overall Status) and scroll down to view 

the Awaiting Action status to see where in the process it is sitting. 

 

Tip: If there is more than one hire event, click the related actions to view initiation date and status (i.e. in 

progress, cancelled, completed) to find the right event.  

 

What is a Pre-Hire?  

A Pre-Hire is an individual in Workday that is not currently assigned to a job. Examples are terminated employees, or 

employees created who have not yet been fully hired.  

 

I clicked Done instead of Open or I was logged out in the middle of a hire process; do I need to start 
over?  

No. The next step in the hire process will be sitting in your Workday inbox as an action item. You will be able to 

proceed from there to complete the hire process.  

 

When do I process a one-time payment? 

One-time payments should be used for non-UW employees who are receiving the following types of payments: 

o Award 

o External reviewer/examiner/assessor 

o Honourarium of $500 or less 
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o Research participant payment of more than $300 

o External guest speaker/lecturer 

Individuals who qualify for the above payments will need to be hired into Workday as casual employees, following the 

steps in the Hire for a one-time payment user guide. 

• If the person you need to pay is a current UW employee, you will need to fill out the One Time Payment 

Request Form (paper form) to send to Payroll in EC1.  

• If the employee is external but does not fall into one of the categories listed above, confirm the type of 

payment with payroll@uwaterloo.ca and they will let you know how to proceed. 

 
Why hasn’t my casual employee been paid? 

Casual employees are paid by entering hours into the Time Entry system of Workday. They first need to be hired into 

Workday and once the hire is finalized, you, the employee, or a timekeeper on your team need to enter time for them 

by following the Enter time for casual staff user guide. If the employee or a timekeeper entered the hours, you will 

need to approve them in Workday in order for them to be paid. Please see the Pay Dates webpage for payroll cut-off 

dates. 

CASUAL JOB CHANGE 

 

The steps outlined below will guide you through the steps to initiate a casual extension and/or pay rate change in 

Workday.  

1. In the Workday search bar, type casual job change to initiate the job change task.  

2. In the Worker field, enter the name of the casual employee you will be making the change for. 

3. If they have more than one position, select the appropriate one from the Job drop down menu, otherwise 

this will default.  

Final job change review
Human Resources Administration (HR Ops Partner) 

Job change review
˖ Signing authority˖ Office of Research (if paid from a research account)

Job change review
Manager (if initiator is not the Manager or a delegated approver)

Job change initiation
˖ Manager ˖ Delegate ˖ Campus Partner

https://uwaterloo.ca/workday/workday-user-guides/hire-one-time-payment
https://uwaterloo.ca/human-resources/sites/ca.human-resources/files/uploads/files/one_time_payment_request_form.pdf
https://uwaterloo.ca/human-resources/sites/ca.human-resources/files/uploads/files/one_time_payment_request_form.pdf
mailto:payroll@uwaterloo.ca
https://uwaterloo.ca/workday/workday-user-guides/enter-time-casual-staff
https://uwaterloo.ca/human-resources/support-employees/payroll/pay-dates
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4. In the What do you want to do field, select Casual employee extension and/or hourly rate change 
and select OK at the bottom of the screen.  

 

 
5. The date will default to the start of the next pay period. Leave as is or update it to when this change should 

take effect. 

6. Click Start.  

 

 
7. Scroll down the Details section to edit the End Employment Date (if applicable). 

Note: The first day of work field will default to the job change date; the overall job record will not be 

updated with this start date. 
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8. If updating the hourly rate, scroll down to the Hourly section and click the Edit icon to enter a new rate.  

 

 
 

9. Once the end date and/or hourly rate have been updated, click Submit to send this job change for review. 

Note: if you are a campus partner, it will go to your manager and then to the cost center signing authority and Office 

of Research (if a research account). If you are the manager, it will go directly to the signing authority and Office of 

Research as applicable. 

CASUAL JOB CHANGE REVIEW 
The steps outlined below will guide you through the review of casual pay rate changes and/or appointment extensions 

initiated in Workday. This process is only to be used for those two types of job change.  

1. In Workday, navigate to your inbox to view the pending job change review task.   

 

2. Changes will be indicated with a blue dot and the updated value will be shown alongside the previous value. 
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3. Review the changes and if OK, click the Approve button. If you do not approve, click the Deny button with 

a comment as to why. The initiator can then re-initiate with the appropriate changes if applicable.  

 

 

FLEXABLE WORK ARRANGEMENT REQUEST 
 

Employees may be permitted to work from home for a maximum of four days per week, based on an annual review. 

Full guidelines can be found on the Secretariat website.  

Approval path: 

 

Final work from home request review
Executive Council

Work from home request review
Department Head

Work from home request review
Manager

Work from home assessment questionnaire

Work from home request initiation
˖ Manager ˖ Employee

https://uwaterloo.ca/secretariat/policies-procedures-guidelines/guidelines/work-home-guidelines
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The following will guide you through the Flexible Work Arrangement Request review process in Workday.   

 

1. From the Workday home page, click the inbox icon on the top right.  

 
2. Review the Request Flexible Work Arrangement for the employee including the Start Date requested, End 

Date requested and Days per Week.  

 
 

 

3. Once the information has been reviewed, the request can be approved, sent back to the employee, or denied. 
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a. If the employee needs to revise the work from home arrangement details click Send Back. Enter a 

reason and then click Submit to send back the request.  

 

Once fully approved, Work from home arrangements can be viewed from the worker profile by clicking the Job 

option from the left-hand menu and then the Work from home arrangement tab at the top.  

To view all employees' work from home arrangements, type UW CR Work from home details into the Workday search 

bar to pull up a report.  

TIME ENTRY AND APPROVAL 

 

ENTER OVERTIME FOR AN EMPLOYEE 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 

Time entry without cost 
center override

Initiated by:
Employee or Timekeeper

Approved by:
Manager/delegate

Time entry without cost 
center override

Initiated by:
Manager/delegate

Approved by:
Automatic approval

Time entry with cost 
center override

Initiated by: 
Manager/delegate or timekeeper

Approved by:
˖ Manager/delegate (if 
timekeeper entered)
˖ Signing Authority

˖ Office of Research (if research 
account)

Approval path: 
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2. Select Enter Time for Worker from the Actions menu. 

3. Fill out the Worker and Date fields.  

4. At the top right of the time entry calendar, click the Actions button to select Auto-fill from Schedule. 

This will fill in all regularly scheduled hours for the week.  

 
Note: This screen displays the employee's regular scheduled hours.  

 

5. Click OK to populate the hours into the calendar.  

Note: Uncheck any stat holidays or vacation days.  
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6. Select the portion of the day where the hours will be added (i.e. for hours worked past 4:30 p.m., select the 

afternoon portion of the applicable day) and update to include overtime hours worked.  

 

Note: Leave Payroll Flag field blank. Populating this field will result in unpaid hours. 

Enter a cost center override only if these hours are not paid from the employee’s default account. 

7. The hours entered for the week will display in the Summary section to the right of the time entry calendar. 

8. Once all hours have been entered for the week, click Review to review and submit the hours.  
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APPROVE OVERTIME FOR AN EMPLOYEE 

1. At the top right of the Workday screen, click the inbox icon.  

2. Find the Time Entry Approval request.  

3. Upon review, select the appropriate button at the bottom of the screen – Approve, Send Back, Deny, Close. 

Note: Changes can be made by clicking the time entry submissions in the employee’s time entry screen (Team 
Time > Enter Time for Worker task).  

 

VIEW COMPENSATION RATES AND DEFAULT ACCOUNTS FOR CASUAL STAFF 

Use the Time Entry Data for My Organizations report to view employees’ default hourly rates and default accounts 

prior to entering their time. 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 
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2. Under the View menu options, select Time Entry Data for My Organizations. 
Note: This report can also be accessed by typing the report name into the Workday search bar.  

3. Leave the Supervisory Organization and Worker fields blank to view all employees you have time entry 

access for, or enter a specific organization(s) or worker(s) to view a narrowed list and click OK. 

 

 

 
4. For each employee, view the employee ID, position(s), supervisory organization, rate, and default accounts 

to know whether or not the rate or account needs to be overridden when entering time.  
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Tip: Export this report to Excel by clicking the Excel symbol above the table  or duplicate 

the tab (right click the browser tab and select duplicate) to have the report open in another window while 

performing time entry.  

 

 

ENTER TIME FOR CASUAL STAFF  

 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 

 
2. Select Enter Time for Worker from the Actions menu. 
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3. Fill out the Worker and Date fields and click OK to continue. 

 

 

 

 

 

 

 

4. Click the day on the time entry calendar for which you want to enter time OR to enter time for the week, 

click Actions at the top right of the calendar and select Enter Time by Type.  

 

5.  Under Time Type, select Hours Worked and enter the daily hours worked for the week and click OK at 

the bottom to return to the time entry calendar.  

Note: You must enter time in hours, i.e. half an hour would be entered as .5 

 

6. The hours entered for the week will display in the Summary section to the right of the time entry calendar. 

Note: Leave Payroll Flag field blank. Populating this field will result in unpaid hours.  

Enter a cost center override only if these hours are not paid from the employee’s default account. 
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7. Once all hours have been entered for the week, click Review to review and submit the hours.  

 
 
 
 
 
Note: If time entry is locked for payroll processing, you will receive an Alert notification and there will be no 

Review button to select. To submit these hours you will need to wait until time entry re-opens (typically the 

day before the current pay date).  

 

APPROVE TIME FOR CASUAL STAFF 

Submitted hours can be approved directly from the Workday inbox, or by following the instructions below to first 

view the compensation elements of the submitted time. 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 
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2. Under the View menu options, select Time Entries for Manager Approvals. 
Note: This report can also be accessed by typing the report name into the Workday search bar.  

3. Leave the Worker field blank to view all employees you have time entry approvals for, or enter a specific 

worker to view a narrowed list and click OK. 

 
 

4. Review the number of hours, compensation amounts and accounts (cost center). 

Note: Multiple time entries for the same employee will have a total amount at the end of their list of entries.  

5. When ready to action the time entry, click on the Time Block – time review event in the second column. 
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6. Click Review to bring up the approval screen and Approve, Send Back, or Deny as applicable.  

 

 

 

VIEW STATUS OF REQUEST 

1. Go to the Workday inbox              and click on the Archive tab.  
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2. Find and click on the relevant request in archive list. 
3. Within the View Event screen, click on the Process tab to view Process History. 

 

CHANGE AN APPROVED REQUEST FOR AN EMPLOYEE 

1. On the Workday homepage, click View All Apps to go to the Team Time application. 

 
 

2. Click Enter Time for Worker from the Actions menu. 

3. Fill out the Worker and Date fields. Click OK to continue. 
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4. From the time entry calendar, click on the date that hours need to be modified to make the necessary 

changes in the resulting window. 

5. Once complete, click Submit. 
6. Review Details and Process to confirm change and select Done. 

VIEW HOURS SUBMITTED FOR AN EMPLOYEE 

1. Enter the following report name in the search bar on the home page: UW Reported Time  

 
 

2. Select UW Reported Time Manager / Time Keeper Report 

 

 

 

 

 

3. Enter the worker name and time period for Reported time 

 
4. Click OK to view the report. 
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TIME ENTRY TROUBLE SHOOTING 

I am trying to enter casual hours into the Time application and it won’t let me. 

• You can only enter hours into Workday as early as your start date. Check the start date listed in your worker 

profile. 

• The Time Entry system gets locked during payroll processing and you will receive an alert if you attempting 

to enter hours during this time. Time entry is locked for monthly staff the Thursday the week before the pay 

week and the Monday of pay week at noon for bi-weekly employees. Time entry re-opens the day before the 

pay date and any hours entered at that time will be paid on the next pay run. 

My manager received a request to approve my hours for one of my casual positions but I didn’t 
submit them. 

• If you have multiple casual positions, when hours are submitted for one position, any hours entered for other 

positions are also submitted. There is no limit to the number of times you can submit hours if additional hours 

have been added that need to be approved. Any hours that have already been approved will not go for approval 

again, unless something has changed. 

Because the time entry system requires hours to be approved by week, it is best practice to submit hours at the 

end of each week to streamline the process. 

How do I correct hours that have already been entered? Can I do this even after they have been 
approved? 

• In the Time Entry screen, click on the time block you want to correct. Make your corrections and resubmit the 

hours for that week. Hours corrected after they have already been paid will show as an adjustment on the 

employee’s next pay. 

If time is entered for multiple positions in the same week, which manager receives the approvals? 
Will all hours go to both managers? 
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• No. Hours that are entered on another position will only go to the manager listed for that position. If the hours 

have been submitted already, they will not go for approvals again, even though the summary page shows all 

hours for that week. If the hours are entered and have not been submitted, when you submit your hours for the 

week, it will also submit the additional position’s hours, which will go to the applicable managers for each 

position. 

If I enter a cost center override on hours in time entry, will all associated benefits be charged to the 
override account as well? 

• No, only the hours will be charged to the override account. All associated benefits (vacation pay, employer taxes, 

etc.) will remain charged to the default account. If this is an issue, an additional job can be added with a different 

cost center associated with it to allow all earnings and associated benefits and costs to be charged to a separate 

account. 

What if a casual has three positions - How is overtime determined?   

• Overtime will be applied to the position where the time entry hours take the employee over the 44 hour threshold 
in a week.  

What is the impact of the employment end date on time entry? 

• The end employment date does not terminate employment but is used for reporting and mass termination 

actions by the HR Administration team. If you are entering time for an employee whose end employment date 

has passed, the time entry will still be passed to payroll for processing. 

 

DELEGATION 
Various tasks can be delegated in Workday such as an entry task, inbox reviews and approvals, or both. The steps 

below will help guide you through setting up a delegation for tasks associated with Hire, Time Entry, Time Off, and 

Terminations.  

DELEGATE HIRE TASKS 

1. At the top right of the Workday screen, click the profile icon and select View Profile. 
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2. From your Worker Profile, select Actions and hover over Business Process to select My Delegations. 

 

 

 

 

 

 

 

 

3. Click Manage Delegations to continue. 

 
 

4. Enter Begin Date and End Date and type the delegate’s name in the *Delegate field.  (Note: you must select 

an end date.) 

5. See the options below for next steps depending on the task(s) you want to delegate.  

If you wish your 
delegate to… 

Then under: 1. Start On My Behalf  And under: 2. Do Inbox Tasks On My Behalf 

1 

2 3 
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1. Be able to only initiate 

a hire 

Click the prompt and select By 
Business Process Type > Hire > 
Hire Employee. 

Select For Business Process and:  

a) Type One in the search area and select 

Request One-Time Payment 

b) Type Assign and select Assign Costing 
Allocation  

2. Be able to only 

approve a hire 
Leave the field blank. 

Select For Business Process and:  

a) Type Hire in the search area and select 

Hire and Propose Compensation Hire. 

b) Type Organization and select Change 
Organization Assignments for 
Worker 

c) Type One in the search area and select 

Request One-Time Payment. 
d) Type Assign and select Assign Costing 

Allocation 

3. Be able to both 

initiate and approve 

a hire 

Click the prompt and select By 
Business Process Type > Hire > 
Hire Employee. 

Select For Business Process and:  

a) Type Hire in the search area and select 

Hire and Propose Compensation Hire. 

b) Type Organization and select Change 
Organization Assignments for 
Worker 

c) Type One in the search area and select 

Request One-Time Payment. 
d) Type Assign and select Assign Costing 

Allocation 

 

6. Click Retain Access to Delegated Tasks in Inbox (this will allow both you and the delegate to receive 

inbox tasks). 

1 

2 
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Note: if you retain access, once someone completes a task, it will disappear from both inboxes but will 

show in the archive section of you inbox.   

7. Click Submit.  

DELEGATE TIME ENTRY TASKS 

1. At the top right of the Workday screen, click the profile icon and select View Profile. 

 

2. From your worker profile, select Actions and hover over Business Process to select My Delegations. 

 

 

 

 

 

 

 

 

 

3. Click Manage Delegations to continue. 

1 

2 3 
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4. Enter Begin Date and End Date and type the delegate’s name in the *Delegate field.  (Note: you must select 

an end date.) 

5. See the options below for next steps depending on the task(s) you want to delegate.  

 

If you wish your delegate 
to… 

Then under: 1. Start On My Behalf  
And under: 2. Do Inbox Tasks On My 

Behalf 

1. Be able to only initiate 

time entry on behalf of 

your  employees 

Click the prompt and select By 
Business Process Type > Enter 
Time > Enter Time for Worker 
(delegation only). 

Click None of the above 

2. Be able to only approve 

time entry for your 

employees 

Leave the field blank. 

For Business Process select By 
Module>Time Core>Enter Time or 

type in Enter Time. 

3. Be able to both initiate 
and approve time entry 

for your employees 

Click the prompt and select By 
Business Process Type > Enter 
Time > Enter Time for Worker 
(delegation only). 

Select For Business Process and 

select By Module>Time Core>Enter 
Time or type in Enter Time. 
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6. Click Retain Access to Delegated Tasks in Inbox (this will allow both you and the delegate to receive 

inbox tasks). 

Note: if you retain access, once someone completes a task, it will disappear from both inboxes but will 

show in the archive section of you inbox.   

7. Click Submit.  

DELEGATE ABSENCE AND LEAVE TASKS 

1. At the top right of the Workday screen, click the profile icon and select View Profile. 

 

2. From your worker pofile, select Actions and hover over Business Process to select My Delegations. 

 

 

 

 

 

 

 

 

 

1 

2 3 

1 

2 
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3. Click Manage Delegations to continue. 

 
4. Enter Begin Date and End Date and type the delegate’s name in the *Delegate field.  (Note: you must select 

an end date.) 

5. See the options below for next steps depending on the task(s) you want to delegate.  

If you wish your delegate 
to… 

Then under: 1. Start On My Behalf  
And under: 2. Do Inbox Tasks 

On My Behalf 

1. Be able to only initiate 

absence and leave requests 

on behalf of your  

employees 

Click the prompt and select By Business 
Process Type > Absence 
Calendar>Correct Absence/Enter 
Absence. 

Click None of the above 

2. Be able to only approve 

absence and leave requests 

for your employees 

Leave the field blank. 

For Business Process and in 

the search area type Absence 

and press enter to select:  

a) Absence Calendar 

b) Correct Time Off 

c) Request Leave of 
Absence 

d) Request Return from 
Leave of Absence 

e) Request Time Off 
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3. Be able to both initiate 
and approve absence and 

leave requests for your 

employees 

Click the prompt and select By Business 
Process Type > Absence 
Calendar>Correct Absence/Enter 
Absence. 

For Business Process and in 

the search area type Absence 

and press enter to select:  

a) Absence Calendar 

b) Correct Time Off 

c) Request Leave of 
Absence 

d) Request Return from 
Leave of Absence 

e) Request Time Off 

 

 

6. Click Retain Access to Delegated Tasks in Inbox (this will allow both you and the delegate to 

receive inbox tasks). 

Note: if you retain access, once someone completes a task, it will disappear from both inboxes but will 

show in the archive section of you inbox.   

7. Click Submit.  

DELEGATE TERMINATION AND RESIGNATION TASKS 

1. At the top right of the Workday screen, click the profile icon and select View Profile. 

1 

2 
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2. From your worker profile, select Actions and hover over Business Process to select My Delegations. 

 

 

 

 

 

 

 

 

 

 

 

3. Click Manage Delegations to continue. 

 
4. Enter Begin Date and End Date and type the delegate’s name in the *Delegate field.  (Note: you must select 

an end date.) 

5. See the options below for next steps depending on the task(s) you want to delegate.  

1 

2 3 
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If you wish your delegate 
to… 

Then under: 1. Start On My Behalf  
And under: 2. 

Do Inbox Tasks 

On My Behalf 

Be able to only initiate 

termination/resignation actions  

Click the prompt and select By Business Process Type 
> Termination > Terminate Employee/Terminate 
from Submit Resignation 

Click None of 
the above 

 

 

8. Click Retain Access to Delegated Tasks in Inbox (this will allow both you and the delegate to 

receive inbox tasks). 

Note: if you retain access, once someone completes a task, it will disappear from both inboxes but will 

show in the archive section of you inbox.   

9. Click Submit.  

DELEGATE ALL TASKS 

1. At the top right of the Workday screen, click the profile icon and select View Profile. 

 

1 

2 
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2. From your worker profile, select Actions and hover over Business Process to select My Delegations. 

 

 

 

 

 

 

 

 

 

 

3. Click Manage Delegations to continue. 

 
 

4. Enter Begin Date and End Date and type the delegate’s name in the *Delegate field.  (Note: you must select 

an end date.) 

5. See the options below for next steps depending on the task(s) you want to delegate.  

If you wish your delegate to… 
Then under: 1. Start On My 

Behalf  
And under: 2. Do Inbox 

Tasks On My Behalf 

1. Be able to initiate all business 

processes and complete inbox tasks 

Click the prompt and select All> 
Select all processes. 

Click For All Business 
Processes. 

 

2. Be able to only complete Inbox tasks  Leave the field blank. 

Click For All Business 
Processes. 

 

 

1 

2 3 
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6. Click Retain Access to Delegated Tasks in Inbox (this will allow both you and the delegate to 

receive inbox tasks). 

Note: if you retain access, once someone completes a task, it will disappear from both inboxes but will 

show in the archive section of you inbox.   

7. Click Submit.  
 

DELEGATION TROUBLE SHOOTING 

I set up delegation for approvals and tasks, but my delegate isn't seeing the approval requests or 
tasks. 

Ensure your delegate is clicking the cloud icon/profile picture and selecting Switch Account to act on your 

behalf. Available tasks (business processes) will be displayed on the home page of the delegation dashboard and 

approvals will be available in the delegation inbox.  

I delegated the absence calendar so that other managers in my department can see when my team 
members have booked vacation, but they cannot see it. 

The Absence Calendar cannot be delegated for someone to see the Team Absence Calendar on another manager’s 

team. To view approved absence requests for members on another team, you can go into each individual team 

member’s Time Off summary to see their approved requests. 

Can I set up a delegation so that someone on my team can view one of the manager reports available 
to me? 

Reports cannot be delegated. Most reports can be downloaded to excel so you can download and share them when 

appropriate 

 

1 2 
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If I set up a substitute in Unit 4 for Signing Authority, how does that translate to Workday? 

Signing Authority substitutes in Unit 4 are brought over into Workday as the Signing Authority on the accounts in 

Workday. This means that the substitute will receive Workday approval actions for new hires and time entry (when 

the cost center is overridden) for the accounts they are listed as a substitute for in Unit 4. 

 

RESIGNATION OR RETIREMENT  
The steps listed below will help you through approving and submitting a resignation or retirement. 

APPROVE RESIGNATION OR RETIREMENT 

1. From the Workday inbox find the Submit Resignation request.  

2. Upon review, select the appropriate Action button at the bottom of the screen – Approve, Send Back, Deny, 
Cancel.  

After approving the employee resignation, you now need to complete the termination in Workday 
by following the steps below.  

Note: The employee record will not be terminated if the termination task below is not complete.  

3. Refresh your inbox by clicking the drop down menu caret beside Sort by: Newest or refreshing your browser 

screen.  

 

4. Click on the Terminate: Employee Name task. 
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5. Enter the Primary Reason for termination as Voluntary> Resignation, unless there is another more 

appropriate reason, i.e., if the employee is retiring, select Retirement. 

 

6. Confirm the termination dates.  

Note: The dates will populate based on the resignation dates submitted. 

7. If the terminating employee is temporary (fixed term), check the Close Position check box.  

8. If the terminating a staff employee in a regular position, check the Position available for overlap check box.  
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Note: Only PM positions will have the close and overlap options. 

9. Upload any applicable documents, i.e. resignation letter/email  

10. Click Submit to send for HR review.  

 

END EMPLOYEE CONTRACT/SUBMIT RESIGNATION OR RETIREMENT 

1. On the Workday homepage, click View All Apps to go to the My Team Management application.
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2. Select Terminate from the Actions menu. 

 

3. Select My Team and select appropriate employee. 

Note: Terminate is used to end an employee's only position in Workday (i.e. employee only has one job). End 
Job is used if the employee has multiple positions and you are ending one of the secondary ones (position will 

have a + symbol beside it if it is secondary). If the position ending is the primary job but the employee has 

additional jobs as well, please contact hrhelp@uwaterloo.ca for assistance.  
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4. Click in the Reason section to activate the editable fields and click the prompt in the Primary Reason field to 

choose the appropriate resignation reason.  

Tip: Secondary and Local Termination Reasons may remain blank; or you may use the Secondary Reasons 

field to record further details, if applicable.  

 

 
 

5. Enter the employee’s last day worked as the Termination Date. 

6. If terminating a temporary position, select the Close Position check box. If terminating a regular position, select 

the Is this Position Available for Overlap check box.   

 

7.  Scroll down to attach the resignation/retirement letter in the attachment field. 

8. Click Submit. 

 

REPORTING 
TO ACCESS REPORTS AVAILABLE TO MANAGERS 

There are three ways to access reports available to managers and timekeepers: 

1. Select View All Apps to access the Manager Reports application.  
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2. Search Manager reports in the main Workday search bar and select from the list of search results. 

3. Type the report name in the main Workday search bar.  

Report name Description Access 

UW CR Current 
Worker Detail Report 

Current employee information, 
including: 

• Employee ID 
• Hire date 
• Employee type 
• Full or part-time 
• Business title 
• Location 
• Supervisory organization 
• Default cost center 
• Manager 
• Compensation amount 
• Email address 

Manager 

UW CR Secondments 
and Temporary 
Assignments 

Displays a list of employees reporting to 
you who are on a secondment or 
temporary reassignment and includes: 

• Supervisory organization of 
the contract 

• Business title of the contract 
• Start and end dates 

Manager 
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Report name Description Access 

UW CR 
Compensation 
Spreadsheet 

Compares all temporary and ongoing 
staff’s USG levels and base salaries 
which includes: 

• Most recent hire date 
• Title 
• Annual base compensation 

Manager 

UW CR Headcount & 
Open Position 
Analysis 

Displays current headcount and open 
positions in a graph format. Can be 
drilled down to sort by: 

• Job profile 
• Position number 
• Supervisory organization 
• Time type 
• Worker type 

Manager 

UW CR Emergency 
Contacts 

Displays a list of employees and their 
emergency contact information 

Manager 

UW CR Employees 
with contracts 

Displays a list of employees with end 
dates (i.e. casual employees, students, 
contract staff, etc.) and includes: 

• Title 
• Employee type 
• Hire date 
• End date 

Manager 
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Report name Description Access 

UW CR End date 
report 

Displays a list of employees' end dates 
for the selected supervisory 
organizations and includes: 

• Position number and title 
• Indicates primary or 

secondary position 
• Position hire date 
• Position end employment date 

 

Manager 
 
Campus Partner 

UW CR Workers with 
probation period 
ending 

Displays a list of employees with 
upcoming probation end date and 
includes: 

• Probation start dates 
• Probation end date 
• Extension date (if applicable) 
• Length of probation 

Manager 

Onboarding Status 
Summary 

Displays a list of employees and their 
progress level in the onboarding 
process 

Manager 

My Team's Learning 
Transcript 

Displays your direct reports’ learning 
history 

Manager 

UW CR Staff 
Vacation Balance 
Report 

Displays vacation balances as of a 
selected period in the vacation year 

Manager 

UW CR Work from 
home details 
 

Provides details on your employees' 
active work from home arrangements 
 

Manager 
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Report name Description Access 

Terminations Displays voluntary and involuntary 
termination details for a selected 
period. 

Manager 

UW Reported Time 
Manager/Timekeeper 

Displays a list of employees/a specific 
employee’s submitted time and 
includes: 

• Status (not submitted, 
submitted, approved, denied) 

• Reported date (date worked) 
• Hours 
• Override rate 
• Override cost center 
• Comment 

Manager 

Timekeeper 

UW CR Worker Info 
for Timekeeper 

Displays employee titles and position 
IDs 

Timekeeper  

Time Entry Data 
for My 
Organization 

   

 

Displays compensation information 
related to casual positions and includes: 

• Employee ID 
• Position ID 
• Supervisory Organization  
• Default hourly rate 

Default cost center and costing 
allocations 

Timekeeper 

Manager 
 
 
 

Time Entries for 
Manager Approval 

Pulls time entry approval items from 
the Workday inbox and includes: 

• Employee name 
• Position ID 
• Supervisory Organization  
• Hourly rate (default or 

override, whichever applies) 
• Cost center and costing 

allocations (default or 
override, whichever applies) 

• Hours submitted 
• Dates of hours worked 
• Total amounts to be charged 

 

Manager 
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Report name Description Access 

Time Entries to 
Approve for My Cost 
Center 

Pulls time entry approval items from 
the Workday inbox and includes: 

• Employee name 
• Position ID 
• Supervisory Organization  
• Hourly rate (default or 

override, whichever applies) 
• Cost center and costing 

allocations) 
• Hours submitted 
• Dates of hours worked 
• Total amounts to be charged 

 

Cost Center Signing Authority 

 

REPORTING TROUBLESHOOTING 

Can I set up a delegation so that someone on my team can view one of the manager reports available 
to me? 

Reports cannot be delegated.  Most reports can be downloaded to excel so you can download and share them, if 
appropriate. 

TIME ENTRY AND APPROVAL REPORTS 

Will the PI be able to view the time entry approval reports? 

The approval reports are generated from time entry approvals awaiting action in an individual’s Workday inbox. If the 

time entry has a cost center override and the PI is the signing authority on the account that was entered, they will 

receive an approval action in their Workday inbox and will be able to view the approval report.  Office of Research will 

also be able to view these reports when there are time entry approvals in their Workday inbox. 

Who has access to view the time entry and approval reports? 

Time Entry Data for My Organization – Timekeepers and Managers  

Time Entries for Manager Approval – Managers  

Time Entries to Approve for My Cost Center – Cost Center Signing Authorities 

See the Types of Reports section of the Workday website to view available reports and who can access them. 

http://uwaterloo.ca/workday/workday-user-guides/types-reports
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How do I access these reports? 

The reports that are applicable to you will be located under the View menu option in the Team Time application. The 

report names can also be typed into the Workday search bar for easy access. 

How am I supposed to remember what details were in the report, i.e. rate, cost center? 

The report can be exported to excel by clicking the excel icon on the top right of the table OR you can duplicate your 

browser window by right clicking on the browser tab and selecting “Duplicate”. This will allow you to have the 

information viewable in another window to reference while you are working. 

Will I have to flip back and forth from the report to my Workday inbox in order to approve hours? 

No. You can complete the approvals directly from the report. For more information, please view the Approve Time for 

Casual Staff user guide. 

If an employee has multiple positions, will they all display in the reports? 

Yes, you will be able to see all positions for which you are listed as the timekeeper. If you are approving time, you will 

see the position to which the time is associated. 

Can we add start and end dates to the report for Time Entry Data for My Organization? 

Unfortunately, we are unable to provide access to start and end dates at this point in time. 

Will the reports include student IDs? 

The reports will not contain student IDs or information on student positions. They will only contain information for 

casual employees. 

 

https://uwaterloo.ca/workday/workday-user-guides/approve-time-casual-staff
https://uwaterloo.ca/workday/workday-user-guides/approve-time-casual-staff
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